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06 Line + Paragraph Spacing

Introduction

As you design your document and make formatting decisions, you will
need to consider line and paragraph spacing. Changing the spacing in

a document can improve readability.

Play the video by clicking the link below:
Line + Paragraph Spacing

About Line Spacing

Line spacing is the space between each line in a paragraph. Microsoft Word
allows you to customize the line spacing to be single-spaced (one line high),
double-spaced (two lines high) or any other amount you want. The default
spacing in Word is 1.08 lines, which is slightly larger than single-spaced.

In the images below, you can compare different types of line spacing.

Default line spacing

Lorem ipsum dolor sit amet, cons adipis elit. In
interdum ante ac ornare ullam corper. Vivamus
sUsCipit enim diam, in mattis nulla consequat at.
Pellentesque sit amet luctus quam, id vehicula
nisi. Integer at matus ac magna accumsan bulum.
Phasellus nunc erat, pharetra vitae gravida in,
pulvinar finibus orci. Null lacinia orci vulputate,
rutrum sapien non, tincidunt. Fusce nen fringilla
nibh, maximus molestie nisl. Nunc eu dalor 3 erat
mallis dictum. Vivamus gravida turpis tempeor
efficitur laoreet. Pellentesque habitant morbi.

Single Line Spacing

Lorem ipsum dolor sit amet, cons adipis elit. In
interdum ante ac ornare ullam corper. Vivamus
SUSCIpIt enim diam, in mattis nulla consequat at.
Pellentesque sit amet luctus quam, id vehicula
nisi. Integer at meatus ac magna accumsan bulum.
Phasellus nunc erat, pharetra vitae gravida in,
pulvinar finibus orci. Null lacinia orci vulputate,
rutrum sapien non, tincidunt. Fusce non fringilla
nibh, maximus molestie nisl. Nunc eu dolor & erat
miollis dictum. Vivamus gravida turpis temper
efficitur laoreet. Pellentesque habitant morbi.

Double Line Spacing

Lorem ipsum dolor sit amet, cons adipis elit. In
interdum ante ac ornare ullam corper. Vivamus
suscipit enim diam, in mattis nulla conseguat at.
Pellentesgue sit amet luctus quam, id vehicula
nisi. Integer at matus ac magna accumsan bulum.
Phasellus nunc erat, pharetra vitae gravida in,
pulvinar finibus orci. Null lacinia orci vulputate,
rutrum sapien non, tincidunt. Fusce non fringilla
nibh, maximus molestie nisl. Nunc eu dalor a erat
mallis dictum. Vivamus gravida turpis tempor

efficitur laoreet. Pellentesqgue habitant morbi.

Line spacing is also known as leading (pronounced to rhyme with “wedding”).
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Exercise 06a
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Using the sample as a guide, follow the directions below to complete the line

spacing exercise.

[ ] Open a file on your computer:
Word 06a Template SPACING

[] Save the file in your Documents Folder:
File > Save As > Documents

L] Name your file by typing in the File Name box:
Word 06a YourFirstNamelLastlInitial SPACING
Save as type: Word Document

[] Click Save

To format line spacing:

Single (1.0)

The Bull Frog

When a bullfrog is stretched to its full length, it may
measure up to 36 inches, making it the largest frog in
Morth America. Native to the eastern and central United
States, it has been introduced in such far flung places as
lamaica, Thailand and France. Bullfrogs are aguatic
frogs, but they spend much time on land and can often
be spotted at the water's edge.

A drop-down menu will appear.

[] Move the mouse over the various options. A live preview
of the line spacing will appear in the document.

[] Select the spacing 1.0 (single line spacing).

Select the text you wish to format — select the first paragraph of text.

On the Home Tab, click the Line and Paragraph Spacing command.
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[] Select the second paragraph

Double (2.0)

The Bull Frog

When a bullfrog is stretched to its full length, it may
measure up to 36 inches, making it the largest frog in
North America. Native to the eastern and central United
States, it has been introduced in such far flung places as
Jamaica, Thailand and France. Bullfrogs are agquatic
frogs, but they spend much time on land and can often
be spotted at the water's edge.

[] Choose 2.0 from the drop down menu (double line spacing).
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Fine-tuning line spacing

Your line spacing options aren’t limited to the ones in the
Line and Paragraph Spacing menu (single, double, multiple)

To adjust line spacing with more precision, we will use the line spacing
called Exactly.

When you choose this option, the line spacing is measured in points, just
like font sizes. Generally, the spacing should be at least the same as the
font size or larger.

For example, if you're using 12 pt (point) text, you could use line spacing
between 12 and 15 points.

[ ] Select the following paragraph:

Exactly 12 pt

The Bull Frog

When a bullfrog is stretched to its full length, it may
measure up to 36 inches, making it the largest frog in
North America. Native to the eastern and central United
States, it has been introduced in such far flung places as
Jamaica, Thailand and France. Bullfrogs are aquatic
frogs, but they spend much time on land and can often
be spotted at the water’'s adge.

[ ] Inthe Home Tab, click the Paragraph setting command to open the Paragraph
and Line spacing pop out window.

®— i— i— = =

.
#F— oy I— w Od— w [ i-..-.L 1T
— 5 — e == == L

Ii|

1|
I
I
4
4
4

" Paragraph P

ESM Digital Technology
Page | 4



[] Inthe Paragraph and Spacing dialogue box,
in the Line Spacing drop down menu choose: Exact

[ ] At: Choose 12 pt from the drop down menu.

ly.
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( Paragraph
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Indents and Spacing | Line and Page Breaks

General

Alignment: Left IZI

Dutline level: | Body Text IEI Collapsed by defa

Indentation
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At least

Preview

Multiple

Left: o = Special: By:
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[] Mirror indents
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Eefore: & pt = Line spacing: At
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[] Don't add space between parag ~ngle
1.5 lines
Double

Change the line spacing of the 3 remaining paragraphs in your document.

[ ] Paragraph 2 — change line spacing to Exactly 13 pt

Exactly 13 pt

The Bull Frog

When a bullfrog is stretched to its full length, it may
measure up to 36 inches, making it the largest frog in
Morth America. Mative to the eastern and central United
States, it has been introduced in such far flung places as
lamaica, Thailand and France. Bullfrogs are aquatic
frogs, but they spend much time on land and can often
be spotted at the water's edge.

[] Paragraph 3 — change line spacing to Exactly 14 pt

[ ] Paragraph 4 — change line spacing to Exactly 15 pt
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About Paragraph Spacing

When you press the Enter key, the insertion point is moved down to the next
line. Just as you can adjust spacing between lines (line spacing), you can adjust
the spacing before and after paragraphs, essentially any place where you have
pressed the Enter key.

This is useful for separating paragraphs, headings and subheadings.

In this exercise, we'll increase the space after the paragraphs to separate them
from each other. This will make our document easier to read.

Scroll down to page 2

Select the Lake Sturgeon text from the subtitle down to the bottom of the
story. Note: When setting line or paragraph spacing, It is not necessary to
select every single word or character on the first or last line of a selection.

In the Home Tab, If you click the show formatting symbols icon, ¥ you will
see there are new paragraph lines throughout the text. Wherever a new
paragraph line §] is placed in a document, the paragraph spacing will be
inserted before or after it, whichever type of spacing you choose.

Lake-Sturgeon-
Lake-sturgeon-can-live:

fish,-characterized-by-five-rows-of-
boney-plates,-a-heavy-torpedo-
shaped-body, four-smooth-barbels-
on-the-lower-snout-and-a-
cartilaginous-body-structure_-Large-
lake-sturgeon-can-grow-to-more-
than-8-feet-in-length-and-weigh-as-
much-as-800-pounds.-Despite-the-
name,-lake-sturgeon-are-found-on-
the-bottoms-of both-lakes-and-
rivers-in-Canada-and-the-eastern-
half-of the-United-States.-And-
some-have-even-been-observed-in-
brackish-waters.-The-Great-Lakes-
and-St_-Lawrence-River-basin gse
home-to-the-largest-popu Ia
Extremely-long-lived, lake-stuvgee
can-reach-ages-of- 100-years-or-
more.-They-grow-rapidly-in-their-
first-10-years,-but-reach-sexual-
maturity-more-slowly-than-any-
other-freshwater-fish.-Males-reach-
sexual-maturity-around-15-20- Y
years;-females-a round-20—25-w’a s
In-the-spring-or-early-summer,- :
depending-on-local-water-

temperature, -lake-sturgeon-
migrate-upstream-in-rivers-to-
spawn.-Females-release-50,000-
700,000-egas-that-are-fertilized-by-
nearby-males-and-then-attach-to-
rocky-surfaces -If the-eggs-survive-
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[] Inthe Page Layout Tab, under the Spacing heading, click the arrows on the
right side of the box to 6 pt in the Spacing After Box. Your paragraph spacing
will be changed in the text. You will see space between paragraphs.

DESIGN PAGE LAYOUT REFEREMCES MAILTNGS REVIEW

"# Breaks - Indent Spacing
i Line Mumbers = | 3= Left: 0" 7= Before: |0 pt s
- be Hyphenation = | =% Right: |0" #: After: b pt |
la Parafgraph L\@

[] Select the text in the Salmon story then hold down the Ctrl key to select the
text in the Whale Shark story.

We are not selecting the titles as we don’t want to add space after them.

Salmon

Salmen live along the coasts of both

the Narth Atlantic and Pocific Oceans.

The ecosystemns of the Padfic Coast — from Alaska down to
California — are tied together by one thing: salmon. salmon have
sustained human populations for generations and are the region’s
driving ecological force, but now 28 populations of salmon are listed
33 threatened or endangered.

salmon live along the coasts of the Morth atlantic and Pacific Oceans,
and are also intensively produced in aquacutture all over the world
aswiell.

salmon migrate from fresh water where they are hatched, to oceans
far their adult life. When they are ready to breed, they return to
their fresh water birthing place — often to the very spot in which
they wera bom.

salmon are a wery popular food fish. A simple rule of thumb is that
the vast majority of Atlantic salmon available on the world market
are farmed [almost 35%). whereas the majority of Padfic salmon are
wild caught (greater than S0%).

Whale Shark

The whale shark is the world’s largest fish,

growing as long as 60 feet.

Contrary to its name, the whale shark is not a whale: it is, rather, the
waorld's largest fish, growing as long as 60 feet It is widely
distributed, found worldwide in tropical and warm temperate seas,
except the Mediterranean. As it swims, it sucks water through its
gargantuean mouth, as wide as 5 feet, then filters out plankton and
other microscopic organisms through its gills. 1t is an extremely
patient feeder. Individuals have been observed waiting as long as 14
hours for fish to spawn on reefs in order to eat the eggs. Whale
sharks migrate long distances according to food availability and
water tempergture. One specimen was tracked 8,000 miles across
the Pacfic.

Thought to have evoblved 200 million years ago, one might think that
humans would have had ample time to study the species, but its life
history remains poorly understood, partially because it is both rare
and migratory. Jacgues Cousteau is reported to have observed onby
two whale sharks in his life. Scientists do know that the spedies gies
birth to live young, unlike most fish, the eges hatching in the
maother’'s body. Litters number up to 300 pups, but survival rates are
thought to be bow. If they do survive, they may fve as long as 100-
150 years, reaching sexual maturity around 25 years.

ESM Digital Technology
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[] Inthe Page Layout Tab, under the Spacing heading,
type 6 pt in the Spacing After Box. Your paragraph spacing
will be changed in the text. This will add 6 pt of space after
each paragraph.

PAGE LAYOUT REFERENCES MAILINGS REVIEW

M Indent Spacing

umbers = | 3= Left:  [0" z "= Before: |0 pt :

nation= | =E Right: |0" . Eﬁkﬁer: 6 pt .
a Paragraph P

[] Select the Title Whale Shark.

are farmed [almost 99%), whereas the majority of Padfic zalmon are
wild caught |greater than S0%).

Whale Shark

The whale shark is the world's largest fish,
growing as long as 60 feet.

contrary to its name, the whale shark is not a whale; it is, rather, the
world's largest fish, growing as long as 60 feet. It is widely

You will now add space between Whale Shark and the end of the last story.

[] Inthe Page Layout Tab, under the Spacing heading, either click the arrows to
the left of Before or type 18 into the Spacing Before Box.

PAGE LAYOUT REFERENCES MAILINGS REVIEW

ks Indent Spacing

Mumbers = | 3= Left 0" 1 1= Before: 18pt -

renation - | =% Right |0" ] #:Aﬁer: 0 pt .
a Paragraph a

Your paragraph spacing will be changed in the text.
18 pt of space will be added between the stories.

[] Save your document and email it to your instructor.
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Page | 10



MODULE 5 WORD
06 Line + Paragraph Spacing
2020

Exercise 06b
Using the sample as a guide, follow the directions below to complete a title page.

Open the Word 2013 Application.

For this exercise, you will start from a blank document instead of
a template:

From the Word application, click Blank Document

Save the file in your Documents Folder:
File > Save As > My Documents

Name your file by typing in the File Name box:
Word 06b YourFirstNameLastinitial SPACING
Save as type: Word Document

Click Save

Go to https://www.coolgenerator.com/story-title-generator
to generate a story title

Type the following text on your page, press the enter key after each line:
Your Story Title

Your First Last Name

Word Exercise 6b

Digital Technology

Today’s Date

Select the text

Signs of Moan Dust
Tammy Skye

‘Ward Exercise Gb
Digital Technalogy
January 24, 2019

ESM Digital Technology
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[ ] Inthe Home Tab, centre the text.

With the text selected, make the following changes

[] FontSize: 14
[ ] Font Style: Candara

[] Select the first line of text

Signs of Moon Dust
Tammy Skye
Wiord Exercise 8b
Digital Technology

January z4, 2019

Paragraph P

You will now move the text down on the page. To do this, you will use the
paragraph spacing tool, instead of pressing the enter key several times:

[ | Inthe Page Layout Tab, type 132 pt in the Paragraph Spacing Before box:

PAGE LAYOUT REFERENCES MAILINGS REVIEW

£ Indent Spacing

Mumbers -~ | 3= Left 0" :IEBEfDrE: 132 pt .

enation~ | =¥ Right: |0" o |3 = Afterr |8 pt .
P Paragraph T

You will now move down the last two lines of the text:

[] Select line: Exercise 6b

Signs of Maon Dust
Tammy Sxye
Ward Exercise &b
Digital Technology

January 24, 2014
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Save your assignment and email it to your instructor.

Exercise 06¢

Using the sample as a guide, follow the directions below to complete the exercise.

[] Open a file on your computer:
Word 06c Template SPACING

[] Save the file in your Documents Folder:
File > Save As > My Documents

[ Name your file by typing in the File Name box:
Word 06¢ YourFirstNameLastlnitial SPACING
Save as type: Word Document
Click Save

Invitation 1 - Change the following Line Spacing + Paragraph Spacing

[] Select the 3 lines of text as shown below.

[ ] To bring the text lines closer together,
change the Line Spacing to Exactly 18 pt.
(See pages 4 +5 in this document to locate the line + paragraph spacing tools.)

TEAM BUILDING RETREAT
Birds Hill Park

Hwy 59 North

Thursday, April 5, 9am — 3pm

Canoes, door prizes, free lunch from Sullie's Subs,

scavenger hunt, volleyball, trust walk,

and our first 3 person-4 leggad race! .

ESM Digital Technology
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[] Select the 3 lines of text as shown below.

TEAM BUILDING RETREAT

Birds Hill Park
Hwy 59 North
Thursday, April 5, 9am — 3pm

Canoces, door prizes, free lunch from Sullie’s Subs,

scavenger hunt, volleyball, trust walk,

and our first 3 person-4 legged race!

[[] Change the Line Spacing to Exactly 16 pt

[] Select the text as shown below.

TEAM BUILDING RETREAT

Birds Hill Park

Hwy 59 North

Thursday, April 5, 9am — 3pm

Canoes, door prizes, free lunch from Sullie's Subs,

scavenger hunt, volleyball, trust walk,
and our first 3 person-4 legged race!

[] To add space between the paragraphs of text,
change the Paragraph Spacing After to 8 pt

ESM Digital Technology
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Invitation 2- Change the following Line + Paragraph Spacing

[] Select the 3 lines of text as shown below.

[l To bring the text lines closer together,
change the Line Spacing to Exactly 23 pt.

Skill Building Retreat

FortWhyte Alive
1961 McCreary Rd.
Friday, April 6, 9am — 3pm

Doort prizes, free lunch, games,
skill development focus:

customer service

[] Select the 3 lines of text as shown below.

[] Change the Line Spacing to Exactly 17 pt

Skill Building Retreat
FortWhyte Alive

1961 McCreary Rd.
Friday, April 6, 9am — 3pm

Doort prizes, free lunch, games,
skill development focus:

customer service

[] Select the text as shown below.

[] To add space between the paragraphs of text,
e - change the

/‘: \ Paragraph Spacing
After to 8 pt

Skill Building Retreat
FortWhyte Alive

1961 McCreary Rd.

Friday, April 6, 9am — 3pm
Door prizes, free lunch, games,

skall development focus:
Customer Service

ESM Digital Technology
Page | 16



MODULE 5 WORD
06 Line + Paragraph Spacing
2020

Note: When you add paragraph spacing (spacing before, spacing after),
space will be added only where returnsq] exist.

In many situations, paragraphs are continuous text with a return after
each paragraph.

In this exercise, the paragraphs were created by forcing the end of the
line with a Soft Return by pressing the Shift + Enter keys at the end of
the line.

When you add Paragraph Space After or Space Before, the Soft Returns
are ignored and the 3 lines are treated like one paragraph.

TEAM:BUILDING: RETREATT ) v e

Birds-Hill-Par Soft Return
Hwy-59-Nort Soft Return
Frlday,Apnl 5,8a m"‘3pn@ Regular Return

Canoes,~door-prizes,-free-Iunch-from~ullie's-Sub@ Soft Return
scavenger-hunt,volleyball, trustwalke) Soft Return
and-ourirst-3-person-4leggedrac€!T) Regular Return

[] Save your assignment and email it to your instructor.
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